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Lab 3: The Force Plate and Vertical Jump
I. Before you come to lab...
A. Read through this handout in its entirety.
B. Complete the pre-lab question as part of HW 3, and turn it in with the rest of your HW by 9:30 am Tuesday.
II. Introduction
A. In this lab, you'll explore Newtonian mechanics of an extended, non-rigid object: your own body. Whenever your center of mass accelerates, it must be due to a net external
force; conversely, any time there is a next external force on your body, it will result in motion of your center of mass. This motion can be extremely non-obvious, because your
center of mass can move as a result of a shift in body position rather than an overall movement of your entire body.
B. Learning objectives for this lab:
1. Learn how to use the more sophisticated techniques of error propagation
2. Learn what center of mass means and how to locate it
3. Learn how to apply Newton's 2nd Law to a complicated system (e.g., a jumping person)
III. Background
A. Error propagation: Advanced techniques
The extra handout on error propagation introduces new techniques and equations for doing error propagation problems. By understanding and using these techniques, you
can save yourself quite a bit of calculation. The uncertainties calculated using these techniques are also generally a bit more realistic and a bit smaller than those calculated
using our old "worst-case" method.
1. Recall that our existing method is to "crunch three times": once to get the mean (middle) value of the final answer, once to get the largest possible value, and once to get the
smallest possible value. Then the mean gives the value, and (largest–smallest)/2 is the uncertainty.
2. By using the new techniques instead, you still have to crunch once to get the value (mean), but now you only have to do one more calculation to get the uncertainty.
Sometimes the expression for the uncertainty can look complicated or daunting, but there are useful approximations that we can use, relying on the fact that we only really
need to know the uncertainty to about one sig fig.
3. A word of warning: many of the new error propagation formulas are most easily used and remembered if they are stated in terms of fractional uncertainty (or percent
uncertainty), instead of absolute uncertainty. Make sure you are comfortable with both and can recognize the difference. As an example, if I measure a length to be 2.00 ±
0.12 m, the uncertainty in the length is 0.12 m (or 12 cm), but I could also say that the length is 6% uncertain (with no units), because 0.12 m divided by the value of 2.00 m
is 0.06.
4. Most importantly: Starting with this lab, all error propagation is to be done using the new techniques if at all possible. There are two main ways in which the new
techniques might be inapplicable:
a. when your calculation involves correlated errors. It is often, but not always, possible to re-write your equation so that the errors become uncorrelated. If you can't, you'll
have to fall back on the worst-case method.
b. when your calculation involves some mathematical function other than add/subtract/multiply/divide/raise to a power, e.g. sin or exp or log. For instance, if you measure an
angle to be 30° ± 2°, what's the uncertainty in the sine? Again, you can fall back on the worst-case method: (sin 32° – sin 28°)/2.
5. If you are curious about the derivations of these equations from Gaussian statistics, you can look them up in chapter 5 of Taylor.
B. Newtonian mechanics of an extended object
1. Recall Newton's 2nd Law for a particle or simple object: the sum of the forces on the object is equal to its mass multiplied by its acceleration. At this point in the course,
you've used this fact many times to solve physics problems. Typically, we proceed by drawing the free-body diagram of an object and adding up all the forces on it and then
using Newton's 2nd Law to equate the total force to the object's mass times its acceleration.
2. But what about an extended object or system, which can have many moving parts? Which acceleration are we talking about? Remember that we defined the concept of
center of mass.
a. The sum of all the forces on an extended system can be broken into the sum of external forces (forces from something outside the system which act on objects inside the
system) and the sum of internal forces (forces between objects which are both inside the system). But by Newton's 3rd Law, the internal forces completely cancel when
you add them up. Therefore the sum of all the forces on the system is equal to just the sum of the external forces on the system. (The external forces all have 3rd-Law
partners, too, but they are not forces that act on the system, so we do not consider them when using the 2nd Law.)
b. We can also write Newton's 2nd Law in terms of the rate of change the total momentum of the system's center of mass. If the total mass of the system is constant, this
simplifies to the total mass multiplied by the rate of change of the velocity of the center of mass.
3. The upshot of all of this is: the sum of all external forces on a system is equal to the total mass of the system multiplied by the acceleration of the system's center

of mass:
We'll use this relation to study the mechanics of the human body, which will first require us to think about where the center of mass of a person is.
C. Jumping
1. Whether you are standing or jumping, the only external forces acting on your body are the normal force from the ground and gravity. How can you jump? Raising your center
of mass into the air seems like it would require gravity to diminish or the normal force to grow. Why would either of these happen?
2. The one thing we know for sure is that gravity isn't changing. Therefore, it must be that the normal force from the ground increases as you jump, propelling you into the air.
Because you push off harder on the ground with your legs, by Newton's 3rd Law, the ground must also be pressing harder on you.
IV. Materials
A. Force plate
1. The force plate is simply a flat plate that can measure the normal force exerted by it:

2. By itself, the force plate is basically just a bathroom scale. But when you use it to do data collection with Logger Pro, it can show you the normal force as a function of time,
which is quite powerful.
3. The reading given by the force plate is the y-component (upward component) of the normal force that the plate exerts on you while you are standing on it. So this reading is
positive if the force plate is pushing up on you, but negative if the plate is pulling down on you. (The latter would be quite rare—unless you are wearing sticky shoes, the
2-1force plate.)
reading would just go to zero when your feet are no longer in contact with the

The reading given by the force plate is the y-component (upward component) of the normal force that the plate exerts on you while you are standing on it. So this reading is
positive if the force plate is pushing up on you, but negative if the plate is pulling down on you. (The latter would be quite rare—unless you are wearing sticky shoes, the
reading would just go to zero when your feet are no longer in contact with the force plate.)
4. There is a switch on the force plate that toggles between the two ranges: between -200 N and +800 N, or between -800 N and +3500 N. We'll use the latter setting; with this
range, the force plate reading has an uncertainty of 1 N.
5. The force plate is pretty sturdy, but it can be permanently damaged if you apply very large forces to it (greater than 5000 N). So you should feel free to stand or jump on it,
but don't actively attempt to destroy it, because you might succeed.
B. Digital video camera
You've seen this before, in Lab 2.
V. Procedure
A. Before you begin:
1. Take a picture of yourselves using Photo Booth and drag it into the space below:

2. Tell us your names (from left to right in the above photo):
B. Locate your center of mass!
1. For this part, you'll have to work together with your neighboring lab group. Each group has one force plate.
2. You will need to devise a procedure for finding the center of mass for each of your group members. At each station, you have a long board, a force plate, some tape/
stickers, and a meter stick. Hint: start by putting the board across the two force plates and zeroing both of them.
3. Write your explicit procedure here:
4. Everybody is encouraged to locate his or her CM and mark it with a bright sticker; however, at least one person from each group of 3 must do it.
C. Move your arms!
1. Still working with your neighboring group, devise a procedure to answer the following question:
a. Suppose you are lying horizontally on the board with your arms at your sides. If you then raise your arms so that they are pointing straight up, what distance ∆x_cm does
your center of mass move in the horizontal direction?
b. Write your explicit procedure here:
c. Now perform this procedure for at least one member of each 3-person lab group (it should be somebody whose CM you located in the previous part). Record any
measurements you made, with uncertainties, here:

d. The rest of the lab involves just working with your original group of 2-3 people, so you can split back up into your regular groups at this point. Also, remove the long board
from both force plates and place it against the wall. You won't need it again.
2. You can use the measurements you just took to actually determine the mass of your arms! Assume that the CM of each arm is located at the elbow. Determine an
algebraic expression for the total mass of both of your arms, in terms of your total mass M, the horizontal distance ∆x_cm from part 1, and any lengths that you need to
measure on your own body (define these clearly in your answer). You do not need to show your work, but check your answer with a TF before moving on.

3. Now let's plug in some numbers. The assumption that your arm's CM is at the elbow has an uncertainty of about 2 cm. What is the total mass of both of your arms, with
uncertainty?
4. Zero your force plate (with nothing on it).
5. Have one member of your group stand on the force plate with arms down at his/her sides. You're going to do a similar motion to the arm-raising activity from the previous
part, but this time it will move your CM vertically.
6. Have another member of your group click the

Collect button in Logger Pro.

7. The force plate will then collect data for 10 seconds; you'll see the trace appear on the graph. During this time, have the person who is standing on the force plate quickly
raise their arms so that they are pointing outwards, and then keep them there for the rest of the 10 seconds:

If you need to do it over, just click on

Collect again and take another 10 seconds of data.

8. Paste the graph of the normal force vs time here:

9. Qualitatively, what features do you observe in the graph?

10. Explain your observations in terms of what you know about Newton's 2nd Law:

11. Is the reading on the force plate the same at the end as at the beginning? Why or why not?

12. Make a qualitative sketch of the height of the person's center of mass as a function of time during the 10 seconds. Take a picture of it and include it here:
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Make a qualitative sketch of the height of the person's center of mass as a function of time during the 10 seconds. Take a picture of it and include it here:

D. Jump!
In this part, you will have the opportunity to explore the physics of a standing jump. We encourage everybody to take a turn jumping on the force plate (although you may opt
out if you wish), but in any event, the full analysis should only be done for one jumper per group. Other jumpers will only make one measurement of their jump (time of flight).
1. Set the DV camera shutter speed to 1/500 of a second, if it isn't already.
a. Refer to the "PS2 Experimental Hints" sheets in the green binder if you don't remember how to do this.
2. Set up Logger Pro to take video captures:
a. Here are the Video Capture Options... we'll need.
(1) Video Capture Mode: Video Capture Synchronized with Data Collection
(2) Duration: 10 seconds
(3) Make sure "Time-Lapse Capture" is not checked.
(4) Capture File Name Starts With: MovieCapture
(5) Click on the Camera Settings button.
(a) In the Compression tab, under Motion, Frames per Second: 30
(b) Click OK. (Don't worry if it tells you that the compression mode is not the default.)
(6) Click OK again.
3. Zero the force plate.
4. Have one of your group members stand on the force plate facing the camera. Make sure their CM label is clearly visible. Another group member should stand next to them
holding a meter stick. You will record a standing vertical jump, using both the force plate and the video camera.
5. When you are ready to start filming, click Start Capture. Both the camera and the force plate will begin collecting and recording. (If this doesn't happen, go back to step 2 and
make sure the Video Capture settings are correct.) The capture runs automatically for 10 seconds and then stops.
a. During the 10 seconds, jump up as high as you can and land back on the force plate.
6. Synchronize the movie to the force data:
a. You will use the moment your feet lose contact with the force plate to synchronize the video to the force data. (Although both are collected at the same time, they are on
slightly different clocks so they are not really synchronized to begin with.)
b. In the lower-right corner of the movie window, click the

button.

(1) A synchronization dialog box will open. First, click in the graph on the moment of takeoff. You should see the time corresponding to your click appear in the dialog box.
(2) Next, play through the video frame by frame until you find the very first frame where your feet leave the force plate. The time corresponding to this frame will also
appear in the synchronization dialog box.
(3) Now click OK in the dialog box to sync the movie

c. Once the movie is synchronized with the force data, you can use the

button in the graph and the movie will automatically show the frame corresponding to the

time you are examining. You can also set up a replay control (Analyze → Replay...) to watch the force plate trace and the movie at the same time, at whatever speed you
like.
7. Save the Logger Pro file for this jumper. It is the one you will use for subsequent analysis.
8. Analyzing your jump:
a. Your name:
b. Paste a copy of your force vs. time graph here:
c. At what time t do each of these occur in the above plot: (careful! some of these are trickier than they look)
(1) The start of the crouch preceding jump
(2) The highest point of the jump
(3) The jumper's center of mass reaches its maximum downward velocity during the crouch
(4) The jumper's center of mass reaches its maximum upward velocity
(5) The lowest point of the crouch
(6) The jumper's feet touch the ground at the end of his jump
d. From the force graph, determine how long you were in the air. You will need to zoom in on the graph to measure it accurately.
flight time tf =
e. If we assume that the takeoff and landing occur at the same y-position, we can actually calculate the maximum height reached during the jump from the tf alone (and g).
But you will need to solve a non-trivial constant acceleration problem in order to do so. Find an algebraic expression for the height of the jump in terms of tf and g.
Again, you do not need to show your work, but check your answer with a TF before moving on.

f. From the flight time, calculate the height of your jump:
jump height (from flight time) =
g. Now use Video Analysis to track the motion of your center of mass (conveniently marked with a label in the movie). Use the meter stick to set the scale. You don't have to
mark every frame in the video; begin just before you start to go down into your crouch and stop when you touch down at the end of the jump.
h. After you have added the video analysis points, double-click on the force graph and go to the Axes Options tab. Check the box for Right Y-Axis and have it display the

column "VideoAnalysis|Y"; then click OK. Now your graph will display both the force and the CM position simultaneously, and the

feature will also show the

corresponding frame in the movie.
i. Paste a copy of your graph (showing both Force and Y vs Time) here:
j. From the video analysis, how much did you raise your center of mass from its initial position (when you were just standing there) to the top of your jump?
jump height (from video) =
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From the video analysis, how much did you raise your center of mass from its initial position (when you were just standing there) to the top of your jump?
jump height (from video) =
k. Compare the results of the two methods of measuring the jump height. If they are way off, see if you can figure out why. (Hint: do the two methods measure
the same thing?)

l. The video analysis gives a simpler, more direct, and more reliable measurement. Can you think of a method to correct the time-of-flight measurement to make
it comparable to the video measurement?

jump height (from time-of-flight, corrected) =
m. When you have finished analyzing your jump, go to File → Save As... and name the file with your name.
9. Now open a fresh copy of Lab3.cmbl and repeat the jump for another jumper, from steps 2 through 5.
a. Jumper's name:
b. Paste a copy of your force graph here:

c. From the force graph, determine the time of flight:
flight time =
d. From the flight time, calculate the height of your jump
jump height (from flight time) =
10. (Skip this section if your group has only two jumpers.) Now open a fresh copy of Lab3.cmbl and repeat the jump for the last jumper, from steps 2 through 5.
a. Jumper's name:
b. Paste a copy of your force graph here:

c. From the force graph, determine the time of flight:
flight time =
d. From the flight time, calculate the height of your jump
jump height (from flight time) =
11. After everybody in the group has jumped, you can move on to the next part.
E. Analysis
1. Open the Logger Pro file for the jump on which you did video analysis.
2. In the "Latest" data set, create a new calculated column called "Net Force" which gives the (y-component of) the net force on you (in the y-direction). Remember, the force
plate only reads the normal force.
3. In the "Video Analysis" data set, create a new calculated column called "ma" which contains your mass times the y-acceleration of your CM. (You'll have to take the second
derivative of Y, or the first derivative of your y-velocity.)
4. Create a new graph which has both "Net Force" and "ma" on the y-axis, and Time on the x-axis. Paste a copy of it here:

5. Zoom in on the region where both Net Force and ma are visible. (It will only calculate ma for the times when you put a dot in the video analysis.) What do you observe
about the plots? What can you conclude?

6. What else would you need to know to determine if Newton's 2nd Law applied to the jump?

VI. Conclusion
A. Congratulations! You've reached the end of the lab.
B. Submit your lab report online. Remember to save your work as a pdf file by going to File -> Print and selecting "Save as PDF" from the bottom left corner. Each person must
upload the file to their sapling account.
VII. Pre-lab assignment for Lab 3 from the Problem Set
(These questions are here for reference.) Before doing this problem, read through the lab handout for Lab 3 and the extra handout on error propagation (from the course
website). Then answer the following questions.
A. Suppose you drop a ball from rest from a height of h = 1.50 ± 0.01 m. Just before it hits the ground, you measure its speed to be v = 5.3 ± 0.2 m/s. The ball has a mass m =
100.0 g. Calculate both the initial potential energy and final kinetic energy of the ball, with uncertainty. You may use g = 9.8 m/s2 and neglect any uncertainty in g, as well as
any uncertainty in the mass m. Was mechanical energy conserved during the fall?
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